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UNIT 1
FUNDAMENTALS OF COMPUTER

1.1 Review Brief history of computer

The history of computers starts about 2000 years ago in Babylonia (Mesopotamia), at the
birth of the abacus and many devices were invented during different periods as listed in the
table.

Abacus

TTTITTTT T )

Chinese invented a calculating device called —
ABACUS to perform simple addition and !111? _ ‘

subtraction.

Abacus

Napier’s Device

W

John Napier invented a device consisting a set
of eleven rods which carried numbers marked
on them to perform products and quotients of
large numbers.

NO g N

Jox

Slide Rule

Robert Bissoker invented Slide Rule in 1632,
which can perform arithmetic and
trigonometric functions.

Pascal’s Calculating Machine (Pascaline)
Blaise Pascal developed a mechanical
calculating machine. It was the first real
desktop calculating device.

It consists of a set of toothed wheels on which
digits were engraved form 0 to 9. Arithmetic
operations were performed by turning the
wheels. Pascal's Calculating Machine

Punched card machine 1 : ;:{:'

Joseph Marie Jacquard invented the first

punched card machine to control textile & '
looms. - ;
Punched Card Machine
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Charles babbage’s Engines (1792-1871)
Charles Babbage invented Difference

Engine, which could evaluate accurately
algebric expressions and mathematical tasks
upto 20 decimal places.

The modified device was called Analytical
Engine. It was an automatic computing
machine.

The parts and principle of Analytical engine is
similar to today’s computer. Hence, Charles
Babbage is called the “Father of Computer”.

Charles babbage's Engine

Charles Babbage: A ngine 1837

Analytical Engine

Mark-1 Digital Computer

Howard Aiken invented the first electro-
mechanical computer in 1937. It used the
punched cards and the principles of computer
as stated by Charles Babbage. It could
multiply two 20 digit numbers within 5
seconds. Made lot of noise. Occupied several
rooms.

e

Atanasoff Berry Computer (ABC)

The First Electronic Computer (ABC) was
developed by John Vincent Atanasoff and
Clifford Berry. This used Vacuum Tubes for
storage, arithmetic and logical functions. It
could perform 5000 additions and 350
multiplications in 1 second.

ENIAC (Electronic Numerical Integrator
and Calculator)

Presper Eckert and John Mauchly developed it
in 1940. It used 18,000 vacuum tubes, 70,000
resisters, 10,000 capacitors and 60,000
switches weighted 27 tons and occupied over
5,000 square feet of space. It consumed 150
KW of power.

EDVAC (Electronic Discrete Variable
Automatic Computer)

The first stored program electronic computer
was developed in 1949 using Neumann’s idea
of stored program concept.
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UNIVAC (Universal Automatic Computer)

It was developed by Eckert and Mauchly
during 1946 to 1951.

It was the first commercially available
computer.

Microprocessor

The first micro processor chip INTEL 4004
was developed in 1971 by INTEL
Corporation. It laid the foundation for the
development of Personal Computer.

Personal computers

The first personal computer was developed in
1974,

Personal computer

1.2 Basic components of computer
e There are three major units of Computer.
1. Input Unit
2. Central Processing Unit (CPU)

3. Output Unit

CPU

Contral Unit

Arithmetic
& Logic Unit

Figure 1.1: Components of computer
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# Input Unit

e Input Unit accepts the input data from the user via input devices such as Keyboard,
Mouse.

e Other input devices will be discussed in chapter 1.3.
# Central Processing Unit
CPU consists of three subsystems,
1. Memory Unit
2. Control Unit
3. Arithmetic and Logical Unit
# Memory Unit
e Memory Unit stores the data and information.
e Basic unit of memory is bit.
e A bit can hold only one of two values: 0 or 1.
e Units derived from bits are,
1 bit = Binary Digit (0 or 1)
8 bits = 1 byte
1024 bytes = 1 KB (Kilo byte)
1024 KB = 1 MB (Mega byte)
1024 MB = 1 GB (Giga byte)
1024 GB =1 TB (Terra byte)
1024 TB = 1 PB (Peta byte)
There are different types of Memory that will be discussed in chapter 1.6.
# Control Unit
e Control unit generates signals that direct the operation of memory and datapath.

e The control signals, instructs the memory to send or receive data, instructs the ALU
about the operations to perform and route data between parts of the datapath.

# Arithmetic and Logical Unit
e ALU performs arithmetic operations such as addition, subtraction, multiplication

and division.
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e It also performs logical operations such as AND, OR, NOT.

# Output Unit

e Output unit is used to display the output via output devices such as monitor,
projector.

e Other output devices will be discussed in chapter 1.3.

1.3 Different 1/0O Devices

# Input Devices
e Input devices are used to get data and instructions from the user.

e These devices convert data and instructions to a form that can be recognized by
the computer (ie, binary language)

# Types of Input devices
e Keyboard
e Mouse
e Scanner
e Joystick

e Digital Camera

Input Devices

camera

\ & .

Bar Code keyboard flatbed scanner
Reader (OCR)

Figure 1.2 : Input Devices
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# Keyboard

e Keyboard is the most commonly uesd input device. Used to enter data and
instructions.

e |t converts keystrokes into electrical signals that a computer can understand.

e Types of keyboard are

# Mouse

e Mouse

o Standard keyboard
o Multimedia keyboard

o Wireless keyboard

is the most popular point-and-draw device.

e Types of mouse

# Scanner

o Mechanical mouse

o Optical mouse

A scanner is an electronic device which can capture from physical items and convert them
into digital formats, which in turn can be stored in a computer.

e Common scanner devices are,

©)

VI-STD

MICR (Magnetic Ink Character Recognition) : Used by banks to find the
genuinity of the cheques.

OMR (Optical Mark Reader) scanner: Used to evaluate OMR sheets.

OCR (Optical Character Recognition) scanner: Used to read printed
characters from the hard copy and convert into softcopy.

Barcode reader : Used to read the barcode of the products and get the details
about it in the stores.

QR Code (Quick Response Code): It is an advanced version of Barcode
designed in 1994. It consists of black squares arranged in a square grid on a
white background, which can be read by an imaging device. QR code can be
scanned using a smartphone, no need of any specific device. It can be scanned
from any direction. Due to the extremely fast scanning facility, it is now
widely used to get to websites quicker and it can also be used for
advertisements.
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# Joystick
e Used to control player movements in the video games.
# Digital cameras

e Used to create image of an object in digital form that can be stored and interpreted by
the computer.

# Output Devices
Output devices are used to display the output or to take hardcopy of the output.
# Types of output devices

e Monitor

Printer

Plotter

Projector

Speakers
# Monitor
e Monitors are used to display the output.
e Types of Monitor
o CRT (Cathod Ray Tube) Monitor
o LCD (Liquid Crystal Display) Monitor
# Printer
e Printers are used to produce hard copy (print on paper) of the documents or images.
e Types of printers will be discussed in chapter 1.7.
# Plotter
e Plotters are like printers but used to print graphic output of varying size.
e Used to print Blue print , Maps.
# Projector
e Used to project information from a computer on a large screen.
# Speakers

e Speakers are used to listen audio files.
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1.4 Computer Languages

A Computer language includes various languages that are used to communicate with a

Computer machine. A Computer can understand only binary language.

# Types of Computer Language
e Low level language

e High level Language

Computer

Languages

Low level High level
Language Language

l

1
1 1

Machine Assembly
Language Language

Figure 1.3: Types of Computer Languages

# Low level Language

e Low level languages are the machine codes in which the instructions are given in

machine language in the form of 0 and 1 to a Computer system.

e Low level languages are divided into two types
o Machine language
o Assembly language

# Machine language

e Machine language is written in machine code which represents 0 and 1 binary digits

inside the Computer string which makes it easy to understand and perform the

operations.

e An advantage of using Machine language is that there is no need of a translator or an

interpreter to translate the code, as the Computer directly can understand.
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e Disadvantages of using Machine language is that it is difficult to remember the

operation codes, memory address and also hard to find errors in a written program. It

is machine dependent.

# Assembly Language

Assembly Languages are written using Mnemonic codes.

A mnemonic is a symbolic name for a single executable machine language
instruction (an opcode) and there is at least one opcode mnemonic defined for

each machine language.

An assembler is used to convert assembly level language into machine level

language.

# High level Language

High level languages look similar to the English language, and hence are better
understood by the programmers.

The translator may be an interpreter and Compiler, helps to convert high level
language into binary code for a Computer to understand.

There are various high level programming languages like FORTRAN , COBOL
and Pascal.

1.5 Software definition and its types

# Software

A set of programs to perform a particular task is called Software.

There are two types of Software

1. System Software

2. Application Software

System Software

A set of program used to control and co-ordinate the computer system is called System
software. For example Operating System, Device Drivers , System Utilities, etc.,

e Device drivers

o A device driver is a system software developed to allow interaction with hardware

VI-STD

devices. This acts as an interface for communicating with the device, connected to
the CPU.
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e System Utilities

©)

Utility software is system software used to analyze, configure, optimize or
maintain a computer. Examples for system utilities are Anti-Virus, Backup
software, Disk Cleaners and Disk Formatters.

Anti-virus utilities scan for computer viruses and remove them.

Backup software makes copies of all information stored on a disk and
restores either the entire disk (e.g. in an event of disk failure) or selected files
(e.g. in an event of accidental deletion).

Disk cleaners find files that are unnecessary to computer operation, or take up
considerable amounts of space. Disk cleaner helps the user to decide what
to delete when their hard disk is full.

Disk formatters prepares a data storage device such as a hard disk drive,
solid-state drive, floppy disk or USB flash drive for initial use.

e Operating System

An operating system (OS) isa system software that manages computer
hardware and software resources and provides common services for computer programs.

Functions of Operating System

Booting: Booting is a process of starting the computer operating system. It starts
the computer to work. It checks the computer and makes it ready to work.
Memory Management : In multiprogramming, the OS allocates memory to the
individual process as required

Disk Management : Operating system manages the disk space. It manages the
stored files and folders in a proper way.

Process Management : CPU can perform one task at one time. If there are many
tasks, operating system decides which task should get the CPU.

Printing controlling: Operating system also controls printing function. If a user
issues two print commands at a time, it does not mix data of these files but prints
them separately.

# Application Software

A set of programs to satisfy the user needs are called Application Software.

Functions of application software

Managing information

VI-STD
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Manipulating data

Constructing visuals

Coordinating resources

Calculating figures
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Types of Application Software

Word Procerssor, Spread sheet, Presentation software, Database Management System
(DBMS), Image editing software are different types of Application software.

Word Processor: A word processor is an application software that performs the task of
composing, editing, formatting, and printing of documents.

Examples for word processor are Microsoft Office Word, Word perfect and OpenOffice.Org
Writer.

Spread sheet: Itis an application software for organization, analysis and storage
of data in tabular form. Examples for Spread sheet software are Microsoft Excel, Lotus123.

Presentation software: A presentation programis a software package used to display
information in the form of aslide show. Examples are Microsoft Powerpoint, Softmaker
presentation etc.,

DBMS: It allows the definition, creation, querying, update, and administration of databases.
Examples are Microsoft access, SQL (Structured Query Language).

Image editing software: It is used to edit the digital photo. Examples are Adobe photoshop,
GIMP.

1.6 Computer Memory

Computer memory is used to store data and programs.
# Types of Computer memory
There are two types of memory
1. Primary memory
2. Secondary memory
« Primary memory
Primary memory is also known as main memory.
There are two types of primary memory
1. RAM (Random Access Memory)
2. ROM (Read Only Memory)
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Computer

Memory
Primary Secondary
Memory Memory
| I 1
RAM ROM

Figure 1.4: Types of Computer Memory

# Random Access Memory: It is a temporary memory. The data stored on RAM will be
erased when the power goes switched off. So it is also called as VVolatile memory.

e Types of RAM
o SRAM - Static Random Access Memory.
o DRAM - Dynamic RAM.
o SDRAM- Synchoronous Dynamic RAM
o DDR- Double Data Rate SDRAM

# Read Only Memory: The memory from which we can only read but cannot write on it.
The information is stored permanently in such memories during manufacture. It cannot be

deleted by the user. So it is also called as non-volatile.

A ROM stores such instructions that are required to start a computer. This operation is
referred to as bootstrap.
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Types of ROM

e PROM (Programmable Read Only Memory)
e EPROM (Erasable and Programmable Read Only Memory)

e EEPROM (Electrically Erasable and Programmable Read Only Memory)
% Secondary memory

It is mainly used for storing information on permanent basic. It is slower than primary

memory. Example: Hard disk.

1.7 Different types of Printer

Printers are divided into two categories
1. Impact printers
2. Non-Impact Printers

# Impact printers

An impact printer makes contact with the paper. It usually forms the print image by pressing
an inked ribbon against the paper using a hammer or pins.

Examples of impact printers are Dot-Matrix Printer, Daisy wheel Printer, Line Printer, Drum
Printer.

e The Dot-Matrix Printers
o matrix printer uses print heads containing from 9 to 24 pins.
o These pins produce patterns of dots on the paper to form the individual characters.
o The 24 pin dot-matrix printer produces better quality print.
o Printing speed is 100-600 characters per second.

Advantage
o Inexpensive.

e Daisy-wheel printers

o In Daisy wheel printer the print mechanism looks like a daisy; at the end of each
“Petal” is a fully formed character which produces solid-line print.

o A hammer strikes a “petal” containing a character against the ribbon, and the
character prints on the paper.

o Printing speed is slow typically 25-55 characters per second.

# Non-impact printers

e Non-impact printers do not use a striking device to produce characters on the paper;
and because these printers do not hammer against the paper.

Examples of non-impacted printers are Ink-jet printer, Laser Printer.
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e Ink-jet printers

o Ink-jet printers form characters on paper by spraying ink from tiny nozzles
through an electrical field that arranges the charged ink particles into characters.

o The ink is absorbed into the paper and dries instantly.

o Various colors of ink can also be used.

o Printing speed is approximately 250 characters per second.

Advantages of Ink-jet printer

o These printers produce less noise

o Print in better quality

o Greater speed.

Disadvantages of Ink-jet printer

o The maintenance cost is high.

e Laser printers

o Laser printers produce images on paper by directing a laser beam at a mirror
which bounces the beam onto a drum.

o The drum has a special coating on it to which toner (an ink powder) sticks.

o Using patterns of small dots, a laser beam conveys information from the
computer to a positively charged drum to become neutralized.

o From all those areas of drum which become neutralized, the toner detaches. As the
paper rolls by the drum, the toner is transferred to the paper printing the letters or
other graphics on the paper. A hot roller bonds the toner to the paper.

Advantages of Laser Printer

o The main advantage of Laser printer is its speed & efficiency at which it prints
high-quality quality graphics & text.

o Laser printers does not produce disturbing sounds.
Disadvantages of Laser Printer

o Cost is relatively high when compared to other printers.
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EXERCISES
I. Fill in the blanks:

1) Speaker is an device.

2) Primary memory is also known as 'Main Memory' and Seconday memory is also

known as memory.

3) Keyboard converts the keystrokes into that a

computer can understand.

4) CPU stands for

5) works as both input device as well as output device.

(Touch screen / Mouse ).

I1. State True of False
1) Computer can understand only the language of 1's and 0's.

2) Generally capacity of Primary memory is bigger than the capacity of Secondary
memory.

3) Optical devices work based on the principals of light.
4) When there is no power supply all the contents of ROM will be erased.

5) AND, OR, NOT are arithmetic operations.

I11. Memory conversions

1) 4KB = bits.

2) 200 MB = KB.
3)1B=_____ b

4) 2TB= GB.

5) MB =5 GB.
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IV. Short answer type questions

1) Name any four input and four output device.

2) Draw a neat diagram of different components of computer and show how they are

connected to each other.

3) Define Software. What are the different types of software?

4) What is a device driver?

5) What is the difference between software and hardware?

6) What is the difference between Primary memory and Secondary memory?
7) What is the difference between System software and Application software?

ACTIVITIES

1. Showing an Input device and an Output device.
2. Showing RAM and ROM.
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UNIT II
WORD PROCESSING (MS WORD)

2.1 Header and Footer

The content in the Header will appear at the top of each page of the document. The content in
the Footer will appear at the bottom of each page of the document.
# Steps to include Header

e Click on Insert menu.

e Click on Header option in the Header & Footer group.

e The build-In options appear asdshown below,

Built-In
Blank

1> |

[Type text]

Blank (Three Columns)

[Type text] [Type et [Ty wnt]

Alphabet

[Type the document title]

[Type the document title] | [Year]

e Select the desired option
e Type text tag will appear on the window. Type the content to appear in the header.
e Click on Close header and footer option in the close group.

e The typed text will appear on the top of each page of the document.

# Steps to include Footer
e Click on Insert menu.
e Click on Footer option in the Header & Footer group.
e The build-in options appear.
e Select the desired option.
e Type text tag will appear on the window. Type the content to appear in the footer.
e Click on Close header and footer option in the close group.

e The typed text will appear on the bottom of each page of the document.
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2.2 Formatting of Paragraph

# Steps to Format paragraph
Formatting a paragraph allows you to change line spacing, indent lines and paragraph.

The tools in the Paragraph group of Page Layout menu are used to format the Paragraph.

fiew View
Indent Spacing
IS Left: 0 z $§ Before: 0 pt <
£2 Right: 0’ 5 || X= After: |10 pt =

Paragraph 4

Changing Paragraph Alignment

Paragraph alignment allows the text to be aligned center, left, right, or justify (which means
aligning it between both the right and left margins).

# Steps to Change Paragraph Alignment

e Select the paragraph to be aligned.

e Click on Home menu.
e Tools for alignment appears as shown below,

‘ Justify
Right

Centre

Left

e Click on the required alignment tool.

Indenting Paragraphs

Indenting paragraphs allows to set different margins for different lines of text.

# Steps to indent paragraph
e Keep the cursor before the line for which indent has to be increased or decreased.
e Click on the Home menu

e Select the indent buttons in the 'Paragraph’ group.
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Increase
Decrease

e Aclick on the respective tool will allow the text to indent left or right. The indention
increases each time you click on the button.

Alternative method

Keep the cursor before the line for which indent has to be increased or decreased.
Right click and choose paragraph option.

Paragraph dialog box appears as shown below,

-
Indents andSpac | Line nd pageBreks |
General

Aigrment: Left v
Quine level: [BodyText [

e Click the Indents and Spacing tab.
e Set the indentions.
e Click on Ok button.

Add Borderss or Shading to a Paragraph

Borders and shadings can be added to a paragraph, many paragraphs or to an entire page.

# Steps to add borders and shadings to a Paragraph

e Select the paragraph to which border and shading has to be applied.
e Click on the border button in the paragraph group.

e A dropdown menu of borders option will appear.

e Click on the Borders and shadings option

e The Borders and Shading dialog box appears as shown below,
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Borders and Shading__ - — (L2 o]

Gorders | ageBorder | shoding |

Setting: Style

Preview

Click on diagram below or use
buttons to apply borders

e Choose the border pattern and click on OK.
e Click on the Shading tab.

e The following window appears,

s T T
Borders and Shading \ M

Borders EageBofde(l Shading
Fill
pa Theme Colors
H EEEEEEN

[T =

Standard Colors
HE EEEEE

No Color

Preview

More Colors...

Apply to:

Paragraph EI

C= o)

e Choose the desired color for shading.
e Click on OK button.

Apply Paragraph Styles

e Style refers to the format of the paragraph.

e MS Word offers several built-in styles.

e These include headings, no spacing, subtitles, emphasized text, list paragraph, etc.

# Steps to apply style to a paragraph
e Click on'Home' tab
e Many styles appear as shown below in the Styles group.

|AaBbCcD | AaBbCcD AaBbCi AaBbCc AaBbC: AaBbCcL AaBbCcD  AaBbCcD -
fNormal |7 NoSpaci.. Headingl Heading2 Heading3 Heading4 Heading5 Heading6 -

Styles

e Scroll through these styles to find the suitable one.

e Click on the selected style.
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2.3 Mail Merge

It is an advanced feature of MS Word, which allows to generate any number of letters in

which some content of the letter being different and major content remains the same.

For example, to send a birthday invitation to many people, the content remains the same,

only the recipient address will be different in each letter.

So any number of invitations can be prepared from a main document and the data source.

This can be achieved with the help of mail merge.
# Steps for Mailmerge
There are 3 major steps,
1. Creating the Main document
2. Creating the Data source
3. Merging the field
1. Creating a Main document
# Steps to Create the Main document prepare

e Open a new document in MS Word.

e Type the complete body of the letter. Leave sufficient space where the recipient
address has to be included.

e Format the letter.

e Save the file.
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Blank space to insert the
fields to be merged

Dear friend,

Thope this letter finds you in the best of health and spirits

You will be glad to know that my birthday falls on 20% May. I am going to celebrate my
birthday at home. We shall have a dance and music program. There will be a party at 6.30
pm. I have invited all my friends. I hope you will also come and join my birthday party.
Convey my regards to uncle and aunty.

Yours

Rajesh

Screen shot of a main document

W
e Click on Start Mail Merge command in the Start Mail merge Stﬁ;,‘ ;jé
Merge ~ |Recipients ~ Recipient List || Merg
group in the Mailings tab. A Letters

. . . b= E-Mail Messages
e Click on letters in the appearing drop down menu.

=1 Envelopes...

5= Labels...

2. Creating the Data source =k Diecoy

[iw/| Normal Word Document

|z Step by Step Mail Merge Wizard...

# Steps to Create the Data Source

= o
e Click on Mailings tab St;ﬁii, ;‘,?i

- B . . . Merge ~ Recipients v/ Recipient List
e Click on Select Recipients option in the Start Mail Merge group. 2. Type New List..

. . . I | F]  Use Existing List..,
e Click on Type New List... option from the drop down menu. 6| setectfrom Outtook Contacts..
e The New Address List dialog box appears as shown below,
New Address List A=)
Type recpient information in the table. To add more entries, dlick New Entry.
[ WP S[PaNem  viisilem | CovesNow v | e nel v
7]
donery ) [ endo )
[ pelete Entry | | customize Columns... | [ o [ cana |

Click on Customise Columns button to select the field names to be included in the
Data source.

The following Customise Address List dialog box will appear as shown below,
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r
Customize Address List . .

Field Names

:
First Name

Last Name

Company Name

Address Line 1

Address Line 2 Rename...
City

State

ZIP Code

Country or Region
Home Phone
Work Phone
E-mail Address

Delete

Ll

:

Move Down

g

Cancel

(S

e By default some fields are shown in the dialog box, Select the unwanted field name
and click on delete button.

e Click on Add button to add new fields
e After adding all the required fields, click on Ok button.

e The selected fields will appear as shown below,

f New Address List | —— £ M
Type recipient information in the table. To add more entries, dick New Entry.
[ Name v | Address Line 1+ [ Address Line 2 [ Cty - | State -]
o]
I 0
((Newnty | [ End... ]
=" o)
4

o Type the entries in the first row.

e Click on New Entry button to add a new entry.

e After adding all the entries, click on Ok button.
; ?
New Address List — L — uﬂ
Type redpient information in the table. To add more entries, dick New Entry.
Name v | Address Line 1 v | Address Line 2 [ City v | State =

I Keerthana 11, Gandhi Street Near Market Ro... Nallanur Tamilnadu
|| Aniket 13, Kaveri Anushaktinagar  Mumbai Maharashtra
|__|Janu 16, Ganga Anushaktinagar Mumbai Maharashtra

)

I

L
[ New Entry ] [ Eind... ]
[ Delete Entry | | customize Columns... | [ ok |[ cancel
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e A Save Address List dialog box will appear as shown below,

Y

2] seve Address it ‘ m -

*% 21 « My Documents » My Data Sou P
e R - 9
M Desktop I

Seve as type: | Microsoft Office Address Lists (*.mdb)

e Type the file name and Click on Save button.

e The data source will be saved automatically with .mdb extension.
3. Merging the field

# Steps to Merge the fields

e Open the main document and keep the cursor where the field % P Rules ~
has to be inserted. —1 |4 Match Fi
fnsert Mergel |
e Click on Insert Merge Field command in the Write & Insert Field~ | (2] Updatel
Fields group. PN

Address_Line_1

Address_Line_2
drop down list. Click the field to be merged with the main City

e The field names available in the data source will appear in the

document. The field will be inserted in the main document. State
e To add more fields again repeat the previous step.

e The main document will appear as shown below,

«Name»

«Address_Line_1»
ki T
«City»

«State»

Dear friend,

Thope this letter finds you in the best of health and spirits

You will be glad to kno that my birthday falls on 20% May. I am going to celebrate my
e. We

all have a dance and music program. There will be a party at 6.30
dallm fnend I hope you will also come and join my birthday party.

Convey my regards to uncle and aunty

e Click on Finish & Merge option in the Finish group.

e Click on Edit individual document to merge to a new document.
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e Click on Ok button.

The document will be merged and a new document will be created as shown below,

Keerthana

11, Gandhi Street

Near Market Road

Nallanur

Tamilnadu

Pear friend,

Thope this letter finds you in the best of health and spirits.

You will be glad to know that my birthday falls on 20* May. I am going to celebrate my
birthday at home. We shall have a dance and music program. There will be a panty at 6.30
pm. I have invited all my friends. | hope you will also come and join my birthday party.
Convey my regards to uncle and aunty.

Yours

Rajesh

13, Kaveri

1 hope this letter finds you in the best of health and spirits

You will be giad to know that my bisthday falls on 20 May. I am going 10 celebrate my

birthday at borme. We shall have 2 dance and music program. Mevnnbupmylélo

pm. I have mvited all my friends. I hope you will also come and jom my birthday pasty.

Convey my regards 10 uncle and aunty.

Yours

Rujesh
I —

16, Ganga

Anushaitinagar

Mumbai

Maharashtra

Dear friend,

Thope this letter finds you 10 the best of health and spirits.

You will be giad to know that my birthday falls on 20% May. | am going to celebrate my
birthday at bome, We shall have a dance and music program. Thael'dlbelpm)low
pem. | have invited all my friends, I hope you will also come and join my

Convey my regards to uncle and aunty.

Yours

IR:;&

By default the created document is named as Lettersl.

Save the document with the desired name.
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Note : Our sample data source contains only 3 records, so 3 letters are prepared in a new document by

the mail merge process. If ‘n’  number of records are entered, then it will prepare ‘n’ such
letters in a new document.

2.4 Envelope and labels

# Steps to create an envelope

e Click on Mailings tab
e Click on the envelopes in the create group.

e Envelopes and labels dialog box will appears as shown below

-
Envelopes and Labels LM

Envelopes | Labels

Delivery address: G~

[7] Add electronic postage
Return address: @~ [ omit
| Preview Feed

I

When prompted by the printer, insert an envelope in your printer's manual feeder.

prnt | [ Add toDocument |  options... | [ E-postage Properties... |

e In the Delivery Address, type the recipient address.
¢ Inthe Return address, type the address of the sender.

e Click on Options button, an envelope options window opens as shown below
| Envelope Options @Iﬁ

Printing Options

Envelope gize:

Size 10 (@ 18x%a1/2in) E
Delivery address
From left: |Auto

Alr (4]

From top: | Auto

I | Return address

| From left: |Auto

From top: |Auto

B NEND

Preview

VI-STD ATOMIC ENERGY EDUCATION SOCIETY 26



e Select the envelope size by clicking on the drop down list.

e Delivery address and Return address font size can be edited by clicking on the font
button.

e Click on OK button.

e Address of sender and Receiver will be seen on the envelope.

e Preview before printing the envelope.
# Create labels

e Click on Mailings tab

e Click on labels in the create group.

e In the address textbox, delivery address will appear by default. In case you want to
create labels for return address, click on use return address check box.

e Click on options button and select the number of labels to be printed per page from
the product number drop down list.

e Click on print button to print the labels

e Click on New Document button to get the labels in a new document. A sample label

created with 30 labels in a page is displayed here.

Jhanvi Jhanvi Jhanvi Jhanvi i Jhanvi Jhanvi { Jhanvi Jhanvi Jhanvi Jhanvi
Gandhistreet ' Gandhistreet 'Gandhistreet 'Gandhistreet ‘Gandhi street | Gandhistreet | Gandhi street {Gandhistreet ' Gandhistreet | Gandhi street
MarketRoad ' MarketRoad 'MarketRoad 'MarketRoad MarketRoad 'MarketRoad 'MarketRoad 'MarketRoad 'MarketRoad Market Road
Chennai Chennai Chennai Chennai i Chennai Chennai Chennai Chennai Chennai Chennai

Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi i Jhanvi Jhanvi Jhanvi
Gandhi street  Gandhistreet ' Gandhistreet 'Gandhistreet Gandhistreet Gandhistreet Gandhistreet 'Gandhistreet Gandhistreet ' Gandhistreet
MarketRoad 'MarketRoad MarketRoad 'MarketRoad MarketRoad MarketRoad 'MarketRoad '(MarketRoad 'MarketRoad MarketRoad
Chennai Chennai Chennai | Chennai Chennai Chennai Chennai Chennai Chennai Chennai

Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi Jhanvi
Gandhi street  Gandhistreet ' Gandhistreet 'Gandhistreet 'Gandhistreet 'Gandhistreet Gandhistreet ' Gandhistreet Gandhistreet ' Gandhistreet
MarketRoad 'MarketRoad 'MarketRoad MarketRoad MarketRoad MarketRoad 'MarketRoad 'MarketRoad 'MarketRoad 'Market Road
Chennai Chknnai Chennai Chennai | Chennai Chennai | Chennai Chennai Chennai Chennai

2.5 Page column

e Select the text for which the column format has to be changed. if you do not select
any text, Word will format the entire document.

e Click on the Page Layout tab
e Click on the Columns... in the Page Setup group
e Choose the format from the drop down list .
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e You can select a preset, automatically formatted number of columns with equal
spacing by clicking One, Two, Three, or Four.

e By clicking More columns.... option, number, width, and spacing of the columns can
be customised.

e Click on OK.
2.6 Hyperlink
A hyperlink is a reference to data that the reader can directly follow either by clicking or
tapping.
# Steps to include Hyperlink

e Select the text for which Hyperlink needs to be included.
e Click on Insert Tab
e Click on Hyperlink in the Links group

e Insert Hyperlink dialog box appears as shown below,

» -
Insert Hyperlink M
Select the file be
Link to: Text to display: {Unit 2\header.jpg l ScreenTip... 5 .
linked with the the
Lookin: | | Unit2 selected text
O g
Web Page & Alignment tool.png - Bookmark...
%’.;:‘t | borders and shading dialog box.jpg T
) customised address list.jpg £
Place in This (#/ customize address list.jpg
Document Browsed |i# envelops and labels.jpg
Pages | i# envelops options.jpg
. %! finish & Merge.jpg
Create New Recent = F°°ter'jg
Document Files (3 header.jpg
# indent tooljpg X
ke A ot Zhesder. 0 [=] Select the file to be
E-mail Address I o m J‘ linked and click on
. |Ok button

e Select the file to be linked and click on Ok button.
e Click on ScreenTip button, to display some text as a tip for the user. This will be

displayed when the cursor moves on the text which contains the Hyperlink.
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2.7 Drop Cap

A drop cap (dropped capital) is a large capital letter at the beginning of a paragraph. The size
of a drop cap is usually two or more lines. Mostly used in formatting the document for

newspaper.
# Steps to Insert Drop Cap
e Select the first character of a paragraph.
e Click on the Insert Tab
A=
e Clickon Drop Cap |5, inthe Text group

Cap~

D

e Addrop down list will appear as shown below,

——| None

A_E Dropped

AE In margin

A= ' Drop Cap Options...

e Select the drop cap option from the above list

e The first letter of the selected paragraph will be displayed as a large capital letter as

A

shown below,
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EXERCISES
I. Short answer type questions.
1) Define Header and Footer option in MS-Word.
2) Define Mail Merge.
3) What are the three main steps for performing Mail Merge?
4) What is hyperlink?
5) What is the purpose of Drop Cap?

PRACTICAL EXERCISES

1) The school is going to present a certificate to the students for the
achievements in Co-Curricular Activities. Create a Certificate using MS Word.
In the Data Source enter the Student details such as Name, Class/Sec., Events in
which the student got prize, position, etc., Using mail merge create certificates

for all the students.

2) i. Create a word document on the topic “Water scarcity and Importance of
drinking water”. (Note: Make two paragraphs, one for Water Scarcity and the

other for Importance of Water)

ii. In the Header add the text “Each drop counts” and in the footer add the

text “Save Water”.

lii. Using page column make two columns. Let the contents of “Water
Scarcity” to be displayed in the first column and the contents of “Imporance of

drinking water” to be displayed in the second column.

Iv. Use drop cap at the beginning of each paragraph.
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UNIT- 111

SPREAD SHEET (MS EXCEL)

3.1 Table creation in MS Excel and implementing Various Charts

A worksheet is a collection of cells, where data is entered and can be manipulated.

# Creating a Table in MS Excel
Table is a collection of related data arranged in rows and columns.
Open Microsoft Office Excel.

A workbook opens with 3 work sheets by default.
N RS e -

Home | Insen  Pogelayout  Formuias  Daa  Review  View qmu

41 ‘:‘ CIA N | ]| ZwnpTet
4 copy E v s

P romatpunter | B £ W] O - A [N W0 B clmecvencenter - (B~ % 0|58 %) Condtonal Fomat
Chipboard o Font o Agnment E Number &

General

Calibri -

Al ~Q S |

Select the cells you want to include in the table.
Click on Insert Tab
Click on Table from Tables group

A Create Table dialog box appears as shown below
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&3]

BBl

-
o4

Click on Ok button.
Different Table styles are available in the Design Tab.
Select the required Table Style.

By default the field names will be shown as Columnl, Column 2, etc., rename the Columns
name as required for the table.

SCIENCE  |SST

Purvi S. lyer

Swara Wadekar

Smit Sachin Ware

Table 3.1: Student mark list table created in MS excel
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# Charts

VI-STD

Select the cells you want to chart, including the column titles and row labels.
These cells will be the source data for the chart. In the given example, Cells
B2:G8 is selected.

Click on Insert Tab will appear as shown below,

il xSl )
- - |
Column Line Pie Bar Area Scatter Other

- - - - - - Charts ~
Charts L

In the Chart group different types of chart will be displayed.

Click on desired chart type from the Charts group. For example, Column
Chart has been chosen here.

The chart appears as shown below,

| a5

| a0

35

W ENGLISH
m HINDI

 SCIENCE
mSST

Siddharth Rathod PurviS. Iyer Ayush Meena Swara Wadekar Yohan Mathar Smit Sachin Ware Shravani

Figure 3.1 A chart created for the table shown in 3.1
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Parts of the Chart

—
45
|Grid linelsul [Data Series] | Marks| |Chart Title
4040 40 5 . 40 40 40 40 __ 40 " T I 40 —|Label I
40 8 8 8 8 8
35 . Area
30 2
M r
al25 W ENGLISH
5 l m HINDI
k
i 20 w MATHS
B SCIENCE
15
. mSST
10
l Legend
5
l Plot
0 Area
Siddharth Rathod PurviS. lyer Ayush Meena Swara Wadekar Yohan Mathar Smit Sachin Ware Shravani
[Vertical Axis Tide | Hortzonal Ak Tae]

Figure 3.2: Components of a Chart in Excel

Chart Title: A chart title identifies the graph to the operator and is displayed at the

top of thegraph.

Chart area: Everything inside the chart window, including all parts of the chart

(labels, axes, data markers, tick marks, and other elements listed here).

Data series: A group of related values, such as all the values in a single row in the
chart. A chart can have just one data series (shown in a single bar or line), but it

usually has several.

Axis: A line that serves as a major reference for plotting data in a chart. In two-

dimensional charts there are two axis
o  x-axis (horizontal)
o Yy-axis (vertical).

Plot area: The area where Excel plots the data, including the axis and all markers that

represent data points.
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e Grid lines: Optional lines extending from the tick marks across the plot area, thus

making it easier to view the data values represented by the tick marks.

e Legend: A key that identifies patterns, colors or symbols associated with the markers
of a chart data series. The legend shows the data series name corresponding to each

data marker (such as the name of the blue columns in a column chart).

e Chart label: A data label provides information about individual data markers, such as
the value being graphed either as a number or as a percent.

Types of Chart

Excel provides you different types of charts. Based on the type of data, you can create a
chart. You can also change the chart type later.

Excel offers the following major chart types —

e Column Chart

e Line Chart

e Pie Chart

e Doughnut Chart
e Bar Chart

e Area Chart
e XY (Scatter) Chart
o Bubble Chart
o Surface Chart
« Radar Chart
Each of these chart types have sub-types.

Column Chart

A Column Chart typically displays the categories along the horizontal (category) axis and
values along the vertical (value) axis.

Line Chart

Line charts can show continuous data over time on an evenly scaled Axis. Therefore, they
are ideal for showing trends in data at equal intervals, such as months, quarters or years.

In a Line chart —
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o Category data is distributed evenly along the horizontal axis.
o Value data is distributed evenly along the vertical axis.
Pie Chart
Pie charts show the size of items in one data series, proportional to the sum of the items. The
data points in a pie chart are shown as a percentage of the whole pie.
Doughnut Chart

A Doughnut chart shows the relationship of parts to a whole. It is similar to a Pie Chart with
the only difference that a Doughnut Chart can contain more than one data series, whereas, a
Pie Chart can contain only one data series.

A Doughnut Chart contains rings and each ring representing one data series.

Bar Chart

Bar Charts illustrate comparisons among individual items. In a Bar Chart, the categories are
organized along the vertical axis and the values are organized along the horizontal axis.

Area Chart

Area Charts can be used to plot the change over time and draw attention to the total value
across a trend. By showing the sum of the plotted values, an area chart also shows the
relationship of parts to a whole.

XY (Scatter) Chart

XY (Scatter) charts are typically used for showing and comparing numeric values, like
scientific, statistical, and engineering data.

A Scatter chart has two Value Axes —

o Horizontal (x) Value Axis
o Vertical (y) Value Axis

It combines x and y values into single data points and displays them in irregular intervals, or
clusters. To create a Scatter chart, arrange the data in columns and rows on the worksheet.

Place the x values in one row or column, and then enter the corresponding y values in the
adjacent rows or columns.

Bubble Chart

A Bubble chart is like a Scatter chart with an additional third column to specify the size of
the bubbles it shows to represent the data points in the data series.

A Bubble chart has the following sub-types —
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e Bubble
e Bubble with 3-D effect
Surface Chart

A Surface chart is useful when you want to find the optimum combinations between two sets
of data. As in a topographic map, colors and patterns indicate areas that are in the same
range of values.

To create a Surface chart —

o Ensure that both the categories and the data series are numeric values.
e Arrange the data in columns or rows on the worksheet.
Radar Chart

Radar charts compare the aggregate values of several data series.

3.2 Cell reference in MS Excel

A cell reference refers to a cell or a range of cells on a worksheet and can be used in a

formula so that Microsoft Office Excel can find the data that the formula has to calculate.
Types of Cell reference

There are three types:

o Relative reference
e Absolute reference

e Mixed reference

The type of cell reference is important when writing a formula, since each behaves differently

when copied or moved to another cell.

Understanding Cell References

Cell reference means the cell to which another cell refers. For instance, if in B2 you have

=B3, cell B2 is referring to cell B3. The cell reference in this example is B3

In the formula, =sum(B2:B10), the cell reference is B2:B10. The formula is telling Excel to
add all of the numbers starting in cell B2 through cell B10. Sometimes the cell reference may
be referred to as the cell range because most references in a formula refer to multiple cells

within a range.

VI-STD ATOMIC ENERGY EDUCATION SOCIETY 37



Relative reference

By default, Excel uses relative reference. Relative cell references, when copied to another
cell or across multiple cells, will change based on where you copy them. For example, Look
at the excel sheet given below for calculating the area of a circle when radius is given.

l D3 - £ | =cavs3*B3
A B C D
1 Finding the area of a circle
2 s.no | Radius| pi |areaofthecircle
3 i | 5 3.14 785
4 2 6 3.14 113.04
5 3 8 3.14 200.96
6 4 10 3.14 314
7 5 15 3.14 706.5

The formula for finding the area of a circle is r
So in the cell D3, the formula is given as =C3*B3*B3.

In cells D4, D5, D6 and D7, formulas need not be typed again. Click on the cell D3, now D3
is the active cell. Keep the cursor in the right bottom corner of the active cell a + symbol
appears , hold and press the plus sign to copy the formula down. Automatically, the formulas
in cells D4, D5, D6 and D7 will become =C4*B4*B4, =C5*B5*B5, =C6*B6*B6, and
=C7*B7*B7.

Absolute reference

To make the cell reference to absolute cell reference, $ symbol has to be placed before the

column alphabet and row number.

Unlike relative references, absolute references do not change when copied and pasted in other

cell. You can use an absolute reference to keep a row, column or both constant. For example,

In the calculation of area of the circle , [] value remains constant. So instead of entering the

value from cells C3 to C7, absolute reference can be used.
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%Absolute reference

ca - f | =pBsatea-sa
A B C
1 Finding the area of a circle
2 | pi 3.14
3 s.no | Radius | area of the circle
4 1 ) 78.5
5 2 6 113.04
6 3 8 200.96
7, 4 10 314
8 5 15 106.5

Mixed reference

A combination of relative and absolute reference is called mixed reference. In some

applications we may need to keep the row as contant and column as changing. Then place a $

symbol in front of the row number (B$6) in the formula.
3.3 Functions in MS Excel

A function is a predefined formula that performs calculations using specific values in a

particular order. Functions save the users time because they need not write the formula. For

example, an Excel function called SUM can be used to quickly find the addition value of the

values in a range of numbers.

The parts of a function,

1. All functions begin with the equal sign (=).

2. After the = sign, define the function name (e.g., Sum).
3. Anargument is the cell range or cell references that are enclosed by parentheses.
An example of a function to add a range of cells, A3 through A9 is given below,

VI-STD

equal sigh | R

_=SUM (A3:A9)

. S
function name argument
ATOMIC ENERGY EDUCATION SOCIETY 39



# Commonly used functions in Excel

++ Statistical functions

e SUM: Adds the values entered in the range of cells mentioned in the argument.

The syntax of the function is:

=SUM( numberl, number2, ...)

where the number arguments are a set of numbers that you want to find the sum of.
Example : In table 3.1, enter =SUM(C2:C8) in the cell C9, the addition value of the
numbers from cell C2 to C8 will be displayed. This shows the total marks obtained in

English by all the students.
c9 +(a fe | =SUM(C2:C8) |

1 m-
2 1 Siddharth Rathod
3 2 PurviS. lyer 38 39 40 34 35
4 3 Ayush Meena 39 29 39 35 40
5 4 Swara Wadekar 29 40 38 29 40
6 5 Yohan Mathar 40 39 29 40 38
7 6 Smit Sachin Ware 39 38 30 39 39
8 | 7 Shravani 38 35 36 38 40
"o I N - T N

Figure 3.3: Screen shot of SUM function

« AVERAGE: Calculates the average of a range of cells mentioned in the argument.

The syntax of the function is:

=AVERAGE( numberl, number2, ...)
Example : In table 3.1, enter =AVERAGE(D2:D8) in the cell D9, the average value
of the numbers from cell D2 to D8 will be displayed. This shows the average marks

obtained in Hindi.
L D9 - @ fe | =AVERAGE(D2:D8) ||

1 mum-m
2 1 Siddharth Rathod

3 2 PurviS. lyer 38 39 40 34 35

4 3 Ayush Meena 39 29 39 35 40

5 4 Swara Wadekar 29 40 38 29 40

6 5 Yohan Mathar 40 39 29 40 38

7 6 Smit Sachin Ware 39 38 30 39 39

8 7 Shravani 38 35 36 38 40

o -~ T - T R R

Figure 3.4: Screen shot of AVERAGE function

VI-STD ATOMIC ENERGY EDUCATION SOCIETY 40



e COUNT: The COUNT function counts the number of cells that contain numbers,

and counts numbers within the list of arguments.

The syntax of the function is:

=COUNT( numberl, number2, ...)

Example : In table 3.1, enter =COUNT(E2:ES8) in the cell E9, the numbers of entries
made from cell E2 to E8 will be counted and displayed. This can be used to find the
number of studens attended the maths exam. (Assuming that no mark entries will be

made for absentees).

E9 ~Q .tir| =COUNT(E2:ES) |
1 nm-m_
2 1 Siddharth Rathod
3 2 PurviS. lyer 38 39 40 34 35
4 3 Ayush Meena 39 29 39 35 40
5 4 Swara Wadekar 29 40 38 29 40
6 5 Yohan Mathar 40 39 29 40 38
7 6 Smit Sachin Ware 39 38 30 39 39
8 | 7 Shravani 38 35 36 38 40
o | 77 N T~ T I

Figure 3.5: Screen shot of COUNT function
o MAX: Identifies the largest number in a range of cells mentioned in the argument.

The syntax of the function is:

=MAX( numberl, number2, ...

Example : In table 3.1, enter =MAX(F2:F8) in the cell F9, the maximum value from

cell F2 to F8 will be displayed. This will display the the maximum marks obtained in

Science.

| - i — m
1 mmm-rm_
2 1 Siddharth Rathod
3 2 PurviS. lyer 38 39 40 34 35
4 3 Ayush Meena 39 29 39 35 40
5 4 Swara Wadekar 29 40 38 29 40
6 5 Yohan Mathar 40 39 29 40 38
7 6 Smit Sachin Ware 39 38 30 39 39
8 7 Shravani 38 35 36 38 40

“o T N T U o0 B

Figure 3.6: Screen shot of MAX function
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MIN: Identifies the smallest number in a range of cells mentioned in the argument.

The syntax of the function is:

=MIN( numberl, number2, ...)

Example : In table 3.1, enter =MIN(G2:G8) in the cell G9, the manimum marks
obtained from cell G2 to G8 will be displayed. This will display the the minimum

marks obtained in Social Science.
G9 (s £ [=MiN(G2:G8) |

mmm_mm

1

2 1 Siddharth Rathod

3 2 Purvi S. lyer 38 39 40 34 35
4 3 Ayush Meena 39 29 39 35 40
5 4 Swara Wadekar 29 40 38 29 40
6 5 Yohan Mathar 40 39 29 40 38
7 6 Smit Sachin Ware 39 38 30 39 39
8 7 Shravani

| T — e i e ]

Figure 3.7: Screen shot of MIN function

+* Text functions

CONCATENATE: Joins several text strings into one text string.
The syntax of the function is:

=CONCATENATE(textl,text2,...)

Example: Enter the following in a cell,
=CONCATENATE("Good", " ", "Morning")

The output will be displayed as Good Morning

LENGTH: Returns the number of characters in a text string.

The syntax of the function is:

=LEN(text)

Example: Enter the following in a cell,

=LEN("Hello")

The output will be displayed as 5.

LOWER : Converts all uppercase letters in a text string to lowercase.

The syntax of the function is:

=LOWER(text)

Example: Enter the following in a cell,
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=LOWER("HELLO")
The output will be displayed as hello
e UPPER: Converts all lowercase letters in a text string to uppercase.

The syntax of the function is:

=UPPER(text)
Example: Enter the following in a cell,
=LOWER("hello")
The output will be displayed as HELLO
e TRIM: Removes all spaces from text except for single spaces between words.

The syntax of the function is:

=TRIM(text)

Example: Enter the following in a cell,
=TRIM("Good Morning™)

The output will be displayed as Good Morning

+» Date functions
e NOW: Returns the current date & time.

The syntax of the function is:

=NOW()
The output will be 04-05-2018 16:20

e TODAY: Returns today's date.

The syntax of the function is:

=TODAY()
The output will be 04-05-2018
3.4 Sorting of data in MS Excel

Sorting allows to reorder the data in ascending or descending order.

# Steps to sort in alphabetical order

e Selecta cell in the column you want to sort .
e Click the Sort & Filter command in the Editing group on the Home tab.

e Select Sort A to Z. Now the information in the Category column is organized in
alphabetical order.
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Sort Z to A option allows to sort the data in reverse alphabetical order.

Example: In the table 3.1, Sorting the data based on Name of the students field.

‘( B2 v | S | Ayush Meena
A B & D E F G
7B ROLL NO. | NAMEC : HINDI___|MATHS _|SCENCE lssT |
2 3 Ayush Meena 39 29 39 35 40
3 2 PurviS. lyer 38 =59 40 34 35
4 7 Shravani 38 35 36 38 40
5 1 Siddharth Rathod 40 40 29 40 38
6 6 Smit Sachin Ware 39 38 30 39 39
7 4 Swara Wadekar 29 40 38 29 40
8 5 Yohan Mathar 40 39 29 40 38
0 @57 | g s s

Sorted list

# Step to sort from smallest to largest number

o Selecta cell in the column you want to sort.
e Click the Sort & Filter command in the Editing group on the Home tab.

o Select From Smallest to Largest. The data will be organized from the smallest to
largest.

You can sort in reverse numerical order by choosing From Largest to Smallest in
the list.

Largest to Smallest option allows to sort data from largest to smallest number.

3.5. Filtering data in MS Excel

You can filter data using the AutoFilter feature in Excel 2007 to display only the data that

meets specified criteria. Filtered data can be copied, manipulated, and printed without having

to move it to a new spreadsheet.

Data can be filtered to get specific value based on a specific crieteria.
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# Steps to Filter the data in excel

e Select the Data tab, then select Sort & Filter in Editing group.

e Click on Filter from the drop down menu.

e Drop-down arrows will appear in the header of each column.

e Click the drop-down arrow for the column you want to filter. In this example,
we'll filter the English marks column to filter the students detail who scored 40.

e The Filter menu appears.

e Uncheck the boxes next to the data you don't want to view, or uncheck the box
next to Select All to quickly uncheck all.

e Check the boxes next to the data that you want to filter. In this example, we'll
check 40. (As shown in the Figure 3.8.)

\ c1 - fe | EnGLisH
A B C D E E G
73 ROLL NO. B NAME OF THE STUDENE] ENGLISH [ HINDI B MATHS _[ISCIENCE. BISST B
Ql Sort Smallest to Largest 29 39 35 40
PUI’Vi S. 1 ﬁl Sort Largest to Smallest 39 40 34 35
. Sort by Color > 35 36 38 40
. 40 25 40 38
Number Filters » l 38 30 39 39
W] (Select All) 40 38 29 40
e . 39 29 40 38
sae |7 | a0 | 5 |

Figure 3.8: Screen shot of Number filters

e Click OK. All other data will be filtered, or temporarily hidden. Only the data
of the students, who scored 40 in English subject will be visible.

| c1 - f | ENGLISH

B C D

A E F G
[ROLL NO. 3l NAME OF THE STUDENT ENGLISH [ HINDI _BIMATHS _EISCIENCE EsST__ @
1 Siddharth Rathod 40 40 29 40 38

40

1
5

39 29 40 38

8 5 Yohan Mathar

Figure 3.9: Screen shot of Filtered table
Note: To remove the filtering and view all the data again click on the filter in the Editing

group.
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3.6. Conditional Formatting MS Excel

Conditional formatting is used to format cells according to a particular condition.

# Steps for Conditional formatting in Excel

e Select the range of cells to which you want to apply conditional formatting.
e Click the Conditional Formatting button in the Styles group on the Home tab.

e A menu appears as shown below, with several different options for specifying the
criteria.

W= _ N

| =.)| Wihiight Cells Rules
ﬂ‘ Top/Bottom Rules  »
E=T

E Data Bars

= color Scales

i=| IconSets » |l

[E NewRule..
[E5 Clear Rules 3

° [E] Manage Rules..

e Point to Highlight Cells Rules and then select the criteria you want to use. (Criteria
options include Greater Than, Less Than, Between, Equal To, Text That Contains, A
Date Occurring, and Duplicate Values).

e A dialog box opens, where you can specify the value.

e Enter the values you want to reference in the text box.

e Click the drop-down arrow next to the format options and select the desired
formatting.

e Live Preview shows you what your data will look like. Click the Custom Format
option if you want to create your own formatting selections.

e Click OK. The cells that meet the specified criteria now appear with the chosen
formatting options.

810 v 3 L

A B C D E F G
SB ROLL NO, |NAME OF THE STUDENT |ENGLISH  |HINDI |MATHS SCIENCE SST
2 3 Ayush Meena 39 29 39 35 40
3 2 Purvi S, lyer 38 39 40 34 35
4 7 Shravani £ as 36 38 40
5 1 Siddharth Rathod 40 40 29 40 38
6 6 Smit Sachin Ware 39 38 30 39 39
7 4 Swara Wadekar 29 40 38 29 40
8 5 Yohan Mathar 40 19 29 40 38
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3.7 Workbook & Worksheet
# Workbook

e The workbook is a collection of worksheets.

e When a new excel file is created, a new workbook opens.
e By default the workbook consists of three worksheets.

e More Worksheets can be added to the workbook.

e A worksheet can also be deleted from the workbook.

e A worksheet organizes various kinds of related information.

Formatting * as Table ~ Styles = T Fiter~ Select~

WD . — =
95 | Home | Inset  Pagelsyout  Formuiss  Data  Review  View  Developer  Addns @-2x
@0 4 cu T = T fom: = : § T TS Autosum - ¢
_j e Caibri n AN [T wm] @] ZwepTer General ﬁ y | S B< _!rl o ﬁ ﬂ
J Format Painter L Clear <o

Paste /B £ g% A E X B FE® Megeacenter~ S~ o o [[%8 8 Condtionsl Format  Celt Insert Delete Format

Clipboard o Font “ Alignment 2 Number - Styles Cells Editing

Figure 5.1: A workbook

# Worksheet

e A worksheet is a collection of cells, where data is entered and can be manipulated.

e Acellis an intersection of a row and a column.

e Rows are named with Arabic numbers.

e Columns are named with Alphabets.

e A cell is named as a combination of intersecting column name and row name

respectively. Example: Al
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, (BT - A (0 ] EMeagencene- (B w06 f:nmmg-:m:'s;e:' Insert Delete Format

Clipboard & Font Angnment = Humber Styles Cells

e e o TR R I N[t &

[ a1 -@ A

¢ FEF , ¢ | o | € | & | & | w | v | 3 | & | v | m | N [
a1

2

: Cell name

20
2L (C A Worksheet
2
23
2
s
H 4 b M| Sheet1 |Sheet? ~Sheet3 ~©J
—
C

Ready |

Figure 5.2: A worksheet

e An active cell is a cell which is currently selected. It will be highlighted by a

rectangular box and its name will be shown in the name box. In the figure 5.2 Al is

the active cell.

3.8 Protection of Work book and Worksheet

Workbook can be protected with a Password. This will restrict access to the workbook by

preventing new sheets from being created or by granting access only to specific people.

# Steps to protect the workbook

e Click on the Review menu.
e Click on Protect Workbook in the Changes group.

e The drop down menu appears as shown below,

@ Protect and
- ﬁ Allow Users
Protect Share

Workbook - Workbook L2 Track Chani
| Restrict Editing

| Protect Structure and Windows

| Restrict Permission
@ Unrestricted Access

Restricted Access

Manage Credentials
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e Click on Protect Structure and Windows option to prevent unwanted changes to the

structure of the workbook, such as moving, deleting or adding sheets.

o Adialog box appears as shown below,

' < N
Protect Structure and Windows M

Protect workbook for
[V] structure
[] windows

Password (optional):

| ok || Ccancel

e Type the password and Click on OK button

# Steps to protect the worksheet - )
° Clle on the ReVieW menu Protect worksheet and contents of locked cells
Password to unprotect sheet:
e Click on Protect Worksheet in the Changes !
Allow all users of this worksheet to:
group. VT -
¥ Select unlocked cells b
e The Protect Sheet dialog box appears, o s 3
| Format rows 1
e Type the Password to unprotect sheet. B anaert columns
: Insert hyperlinks
e Click on OK button. Soaet o™ I
oK ] [ Cancel
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EXERCISES
L. Fill in the blanks.
1) function in Excel returns the current date & time.

2) In Excel , a fucntion or formula always starts with symbol.
3) symbol is used to create absolute reference.

4) and charts are round / circular in shape.

5) By default, a work book consists of number of
work sheets.

I1. Short answer type questions.
1) Explain different components of chart with help of a neat diagram.
2) What are the different types of cell reference in MS-Excel?
3) Explain different Statistical functions avaliable in MS-Excel.
4) Explain different Text functions avaliable in MS-Excel.
5) Define Sorting. Write the steps to sort the data in MS-Excel.

6) What do you mean by a function in Excel. Explain with one example.
How it is different from a formula?

PRACTICAL EXERCISES

1) i. Create a table in a new workbook in MS Excel for Cricket Score
Board. (With the fields S. No., Name, Runs/Score, Strike rate, No. of Sixes, No.
of Fours and No. of Vickets taken).

Ii. Sort the data based on the Alphabetical order (A to Z) of Name of
the Player.

iii. Filter the records of the players who scored sixers.

Iv. Highlight the cells in the run column where the score is less than 10
using conditional formatting.

2) Create any type of chart for the table “Cricket Score Board”.
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